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1  Introduction 
Thank you for purchasing a Funktion One Vero system. All Funktion One loudspeaker systems are designed and built in England. Our design philosophy is to 
achieve outstanding sonic accuracy and efficiency through innovative acoustical design. This approach provides immediacy and involvement reminiscent of the 
finest musical instruments. 
 

Reading this user guide will help you to achieve the best performance - just as Funktion One intended. 

 

2  Receiving, unpacking & handling 
Check the system components and quantities against your order to make sure your shipment is complete and in good condition before signing for the delivery. 

 

2.1  Vero component descriptions and identification 
 

Vero main array components 
 

There are three types of Vero array loudspeakers that, together, form a comprehensive vertical array 
 

Á The Vero V60 loudspeaker is a mid/high system that provides very narrow vertical coverage and 60° horizontal 
coverage 

Á The Vero V90 loudspeaker is a mid/high system that provides narrow vertical coverage and 90° horizontal 
coverage 

Á The Vero V315 loudspeaker is a mid-bass system that forms part of a Vero array 
 

Note that each V60, V90 and V315 loudspeaker includes an integral Lambda® rigging system. 
 

Vero ground-stack bass components 
 

V60/V90/V315 systems may be augmented by: 
 

Á The V221 Řǳŀƭ нмέ ground-stack bass system with V132 low bass extension 
ƻǊΧ 

Á The V124 single 24έ ground-stack bass system 
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Vero stackable transport dolly (See Section 7.5 for dolly-mounted ground or stage-wing Vero stacking and  Section 9.3 for truck packing) 
 

Á V-Dolly ς The 4-cabinet V60/ V90/ V315 dolly ǿƛǘƘ ƘƛƎƘ ǇŜǊŦƻǊƳŀƴŎŜ уέ ǿƘŜŜƭǎ and fork-lift provision 
Á Optional protective side and end Runners are available ς see illustration to right Ĕ 

Á Outriggers are available for tilting dolly-mounted Vero stacks or for levelling during rigging operations 
(see Section 7.5 for details) 

Á 4-cabinet padded Dolly Covers are available. These feature index dial windows, handle flaps and a  
squaring lid to allow additional items to be transported on top 
 

Vero amplifier rack 
 

The V-RACK9U amplifier rack includes: 
 

Á 3-phase European AC mains panel providing 3 x 230v phase-to-neutral supplies ς one per amplifier 
Optional USA AC mains panel providing three 208v phase-to-phase supplies ς one per amplifier 

Á Up to 3 x Lab.gruppen PLM+ series 4-channel power amplifiers ς type PLM20K44 
Á Local (managed, non-blocking, gigabit) CISCO SG300-20 Ethernet switch for Dante networking 

 

Each Lab.gruppen PLM+ Series PLM20K44 power amplifier drives up to: 
 

Á 4 x V60 (or V90) + 2 x V315 top + mid-ōŀǎǎ ǎȅǎǘŜƳǎ ƻǊΧ 
Á 6 x V221 bass cabinets* (2.67 ohms per channel) or 8 x V221 bass cabinets (2 ohms per channel) 

*Assumes two lots of 3 x parallel V221s driven in 2-channel (separate-driver) mode 
 

V60/ V90/ V315 loudspeaker cables 
Á VC8EX25M - 25m 8-core extension cable                                                                                                                         4-cabinet V-dolly showing overall dimensions 
Á VC8EX10M - 10m 8-core extension cable                                                                                                                                          (1677mm (w) x 732.5mm (d) without runners) 
Á VC8BB02M - 2m Bass break-out cable 
Á VC8LK1.5M - 1.5m link cable                                       
Á VC8LK02M - 2m link cable 
Á VC8LN01M ς 500mm NL8-to-quarter-turn mil. spec. converter cable 

 

V-FLYTRUNK1 rigging trunk ς containing: 
 

Lambda® flying system 
Á VBAR-MAIN ς Main Vero 2-part loudspeaker system FlyGrid set (for up to 24 enclosures) 
Á Optional VBAR-S - Simple Vero loudspeaker system FlyGrid set (for up to 6 out-fill enclosures) 
Á Optional Outriggers (for levelling the 4-cabinet dolly during rigging operations or for tilting Vero stacks) 
Á V-YS1 - Vero loudspeaker system rear pull-up system                                                                                                              

              (Including 2 x Swing clips, plus spreader bar used when flying more than twelve Vero) 
Á 1-tonne, 3-metre lever hoist                                                                                                                                                      FlyTrunk with Lambda® FlyGrid system 
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2.2  Unpacking and inspecting 
All Funktion One products are tested and inspected thoroughly before being despatched. 
 

Á Inspect your shipment for any signs of abuse or transit damage as soon as you receive it 
Á If your shipment is incomplete or any of its contents are found to be damaged: 

¶ Inform the shipping company 

¶ Inform your dealer 
 

We suggest that you keep some of the original packaging in case you have to return a unit for repair or replacement. 
 

Funktion One Research Limited and its distributors cannot be held liable for product damaged through the use of non-approved packaging, shipping or handling 
methods. 

 

2.3  Standard 24-box Vero touring system components supplied 
 

Note that Projection software will generate άYit listsέ. Click through Docs > Truck List to see a full list of components required for any other system configuration. 
 

8 each V60, V90, V315  Vero System Enclosure 
16 V221                       Vero System Bass Enclosure (or optional 4 x V132 + 12 x V221 Bass system) 
4 VC8EX25M           Vero Cable - 25m extension 
4 VC8EX10M           Vero Cable - 10m extension 
4 VC8BB02M           Vero Cable ς Mid-bass breakout 
8 VC8LK1.5M          Vero Cable - Short Link 
4 VC8LK02M           Vero Cable - Long Link 
4 VC8NL01M           Vero Cable - NL8 to System Connector 
6 V-DOLLY                Vero Transportation Dolly 
2 V-RACK9U            Vero Amp Rack  
2 Mains Distro        Vero Amp Rack Distro  
6 PLM20K44            Lab.gruppen Amplifier PLM+  
2 V-FLYTRUNK1      Vero FlyGrid Trunk 
2 VBAR-MAIN         Vero FlyGrid 
2 V-YS1                     Tilt Strap Assembly 
2 Lever Hoist  1-Tonne, 3-metre lever hoist for Tilt Strap 
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2.4  Handling 
Please handle your Vero system safely to avoid injury. 
 

Á Palletised, wrapped and strapped shipments should only be moved using a fork-lift truck driven by a qualified forklift truck driver 
Á Vero systems are supplied with dollies making them very easy to move around. 

 

We recommend providing staff with suitable manual handling training before they manoeuvre a Vero system. Helpful hints are available free of charge from the 
UK Health and Safety Executive.  See (www.hse.gov.uk/pubns/indg143.pdf).  
 

If your Vero system is destined for an installation, keep it protected by its packaging until the installation site is clean, secure and ready to accept it. 

 

3  Introduction & features 
 

3.1  Vero® V60, V90, V315, V221, V124 and V132 systems 
 

Vero V60, V90 and V315 loudspeaker systems 
The Vero large-format touring loudspeaker system is in a class of its own. Its combination of unparalleled sonic performance and intelligent design provides easily 
deployed audio of the highest standard for arenas, concerts or festivals of any size. 
 

¢ƘŜ ±ŜǊƻ ǎȅǎǘŜƳ Ƙŀǎ ŀƭƭ ǘƘŜ ǇƘȅǎƛŎŀƭ ŀǘǘǊƛōǳǘŜǎ ŘŜƳŀƴŘŜŘ ōȅ ǘƻŘŀȅΩǎ top-level productions with next-generation sound. Geometric Energy Summation (GES) 
enables natural tailoring of the coverage pattern and sound pressure levels to keep sound focused on the audience and minimise off site environmental impact. 
±ŜǊƻΩǎ ŜŦŦƻǊǘƭŜǎǎ ǇƻǿŜǊ ŀƴŘ ŎƭŀǊƛǘȅ can often eliminate the need for inconvenient and costly delay positions where propagation conditions allow. 
 

±ŜǊƻΩǎ patented Lambda® rigging system offers rapid installation and features the unusual and useful capability of enclosure angle adjustment under load. 
 

Vero is a complete system package with amplification, cabling, rigging, transportation dollies, racks and trunks - all optimised for practical and efficient touring. 
 
±ŜǊƻΩǎ ƛƴŘǳǎǘǊȅ-leading electro-acoustic efficiency gives more head-ǊƻƻƳ ŦƻǊ ƭŜǎǎ ǇƻǿŜǊ ŎƻƴǎǳƳǇǘƛƻƴΦ ¢ƘŜ ǎȅǎǘŜƳΩǎ ƴŀǘǳǊŀƭ ǘƻƴŀƭ ǊŜǎǇƻƴǎŜ ŀƴŘ Cǳƴƪǘƛƻƴ hƴŜΩǎ 
ǳƴƛǉǳŜ άƻǳǘ ƻŦ ǘƘŜ ōƻȄέ ǎƻǳƴŘ ƛƳŀƎŜ ǇǊƻƧŜŎǘƛƻƴ is achieved with minimal frequency correction to maintain linearity and headroom. Vero gives artists, engineers 
and concert goers the unprecedented dynamic range, fidelity and satisfaction they deserve. 
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Vero V60 mid/high features 
 

Electro-acoustic 
Á Advanced Andrews-Newsham tuning 
Á 200Hz ς 18kHz frequency response 
Á слх ƘƻǊƛȊƻƴǘŀƭ ŎƻǾŜǊŀƎŜ 
Á Up to 6х ǾŜǊǘƛŎŀƭ ǎǇƭŀȅ ŀƴƎƭŜ between V60s for contiguous coverage 

(large mechanical angles are available should deliberate mid and HF coverage gaps be required) 
Á Funktion One designed drivers with Neodymium magnets 

¶ н Ȅ нрл²Σ млϦ мсҠ ƳƛŘ ŘǊƛǾŜǊǎ 

¶ о Ȅ тр²Σ мΦпέ онҠ IC ŘǊƛǾŜǊǎ 
Á 2 x 8-pin ¼-turn Mil-spec Syntax connectors in parallel 

(A - D link through, 2 x parallel mids on E+/F-, 3 x parallel HFs on G+/H-) 
                                                                                                                                                              
Enclosure & fittings  
Á 15mm thick birch ply enclosure 
Á High durability Polyurea coating 

Á Integral Lambda® rigging system with colour-coded Index dial (blue)  
Á Inter-cabinet locating cones for easy rigging 
Á Generous flip handles                                                                                                                                         ±ŜǊƻΩǎ ŦŀƳƛƭȅΩǎ common cabinet styling 

 
Prediction software 
Á Projection system design and rigging software 

 
Vero V90 mid/high features 
 

Electro-acoustic 
Á Advanced Andrews-Newsham tuning 
Á 200Hz ς 18kHz frequency response 
Á флх ƘƻǊƛȊƻƴǘŀƭ ŎƻǾŜǊŀƎŜ 
Á ¦Ǉ ǘƻ мнΦрх ǾŜǊǘƛŎŀƭ ǎǇƭŀȅ ŀƴƎƭŜ between V90s for contiguous coverage 
Á Funktion One designed drivers with Neodymium magnets 

¶ 2 x нрл²Σ млϦ мсҠ ƳƛŘ ŘǊƛǾŜǊǎ 

¶ н Ȅ тр²Σ мΦпέ онҠ IC ŘǊƛǾŜǊǎ 
Á 2 x 8-pin ¼-turn Mil-spec Syntax connectors in parallel.                               

(A - D link through, 2 x parallel mids on E+/F-, 2 x parallel HFs on G+/H-)                        ±слΩǎ слх ƘƻǊƛȊƻƴǘŀƭ ŘƛǎǇŜǊǎƛƻƴ Ǿǎ ±флΩǎ флх ƘƻǊƛȊƻƴǘŀƭ ŘƛǎǇŜǊǎƛƻƴ 
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Enclosure & fittings 
Á 15mm thick birch ply enclosure 
Á High durability Polyurea coating 

Á Integral Lambda® rigging system with colour-coded Index dial (yellow) 
Á Inter-cabinet locating cones for easy rigging 
Á Generous flip handles 

 
Prediction software 
Á Projection system design and rigging software 

 
Vero V315 mid-bass features 
 

Electro-acoustic 
Á Advanced Andrews-Newsham tuning 
Á 50Hz ς 250Hz frequency response 
Á тлх ƘƻǊƛȊƻƴǘŀƭ ŎƻǾŜǊŀƎŜ ŀǘ нллIȊ 
Á Up to рх vertical splay angle between V315 and adjacent enclosure 
Á Funktion One designed drivers with Neodymium magnets 
Á о Ȅ плл²Σ мрϦ уҠ ƭƻǿ ƳƛŘκ ōŀǎǎ ŘǊƛǾŜǊǎ 
Á Single NL-4, 3 x parallel drivers on 1+/1- 

 
Enclosure & fittings 
Á 15mm thick birch ply enclosure 
Á High durability Polyurea coating 

Á Integral Lambda® rigging system with colour-coded Index dial (red)                                                                              V315 Mid-bass 
Á Inter-cabinet locating cones for easy rigging 
Á Generous flip handles 

 
Prediction software 
Á Projection system design and rigging software 
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Vero V221, V124 and V132 bass systems 
 

±ŜǊƻ ±ннм Řǳŀƭ нмέ ōŀǎǎ ǎȅǎǘŜƳ 
Lƴ ǘƘŜ мфулΩǎ ¢ƻƴȅ !ƴŘǊŜǿǎ ōŜƎŀƴ ǇƛƻƴŜŜǊƛƴƎ ǿƻǊƪ ƻƴ ǘƘŜ ŘŜǾŜƭƻǇƳŜƴǘ ƻŦ ǘƘŜ ŦƛǊǎǘ нмέ 
loudspeaker ever made. Continuous development has resulted in the high-intensity V221 bass 
system which benefits from two of these incredibly robust Funktion One designed нмέ drivers with 
сέ ǾƻƛŎŜ Ŏƻils for maximum power handling and efficiency. 
 

Á Advanced Andrews-Newsham tuning 
Á 40Hz-250Hz Frequency response 
Á Funktion One designed drivers with Neodymium magnets 
Á н Ȅ нмέ ŘǊƛǾŜǊǎ ǿƛǘƘ 2 x 750W, 8Ҡ voice coils. (4Ҡ when connected in parallel) 
Á 107dB - 1W at 1m in half-space 
Á 2 x NL-4 (pin-to-pin), one driver on 1+/1-, the other on 2+/2-                                                                                                       
Á 18mm thick birch ply enclosure 
Á High durability Polyurea coating 
Á Integral pocket handles 
Á Feet that locate into recesses when stacked - to prevent sliding or swivelling 
Á Rear wheels that nest inside flare of adjacent enclosure for efficient truck packing 
Á Optional throat grilles                                                                          

 
±ŜǊƻ ±мнп ǎƛƴƎƭŜ нпέ ōŀǎǎ ǎȅǎǘŜm 
Built to the same high power and efficiency standards and with the same practical features as the V221, the Vero 
±мнп ǎƛƴƎƭŜ нпέ, dual voice coil bass system may also be used with Vero V60/V90/V315 systems. The V124 
provides extended and defined low frequency bass performance in an efficient 992mm (w) x 702mm (h) x 
1186mm (d) package. 
 

Á Advanced Andrews-Newsham tuning 
Á 35Hz-160Hz Frequency response 
Á Funktion One designed driver with FEA-optimised Neodymium magnets 
Á {ƛƴƎƭŜ нпέ ŘǊƛǾŜǊǎ ǿƛǘƘ 2 x 750W, 8Ҡ dual voice coils. (4Ҡ when connected in parallel) 
Á 107dB - 1W at 1m in half-space 
Á 2 x NL-4 (pin-to-pin), one voice coil on 1+/1-, the other on 2+/2-                                                                                                       

 
±ŜǊƻ ±мон ǎƛƴƎƭŜ онέ low-bass system 
±ŜǊƻ ±мон ǎƛƴƎƭŜ онέ 24Hz-70Hz low-bass systems may be used to extend a Vero systems low frequency response down to 24Hz for the ultimate in low frequency 
performance, high-power contemporary music applications and special effects. See Section 6.8 for further details. 
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4  Connector pin-outs and cables 
4.1  Vero connector pin-outs 
 

VC8LN01M 1m NL8 (rack end) to Syntax converter cable then ǘƻΧ 
10m/25m VC8EX10M/25M Syntax male to female (cabinet end) extension cable 
 
 

VC8LN01M NL8 to female Syntax 
system link cable 

VC8EX10M or VC8EX25M male to female 
main extension cable 

 
V60/90 cabinet wiring 

 
Function 

NL8 Syntax SPK socket Syntax SPK pin Syntax SPK socket Syntax SPK male Driver  
Through - to V315 #1 (via VC8BB02M 
mid-bass break-out cable - see below) 

1 + A A A A + 

1 - B B B B 
- 

2 + C C C C + Through - to V315 #2 (via VC8BB02M 
mid-bass break-out cable - see below) 

2 - D D D D 
- 

3 + E E E E + 2 x Mid per cab (up to 4 x V60/V90 via 
VC8LK1.5M/02M Syntax male-female links) 

3 - F F F F 
- 

4 + G G G G + 2 (V90) or 3 (V60) x HF per cab (up to 4 x V60/V90 via 
VC8LK1.5M/02M Syntax male-female links) 

4 - H H H H 
- 

       

VC8BB02M ς 2m Syntax male to 2 x NL4 mid-bass break-out cable for up to 2 x V315 mid-bass per block of 4 x V60/90 
 

VC8BB02M Syntax SPK male to 2 x NL4 breakout 2 x V315 cabinet wiring Function 

Syntax SPK connector pin A NL4 #1         1 + NL4 #1         1 + 3 x V315 #1 drivers + V315 #1 

Syntax SPK connector pin B NL4 #1         1 - NL4 #1         1 - 3 x V315 #1 drivers - 

Syntax SPK connector pin C NL4 #2         1 + NL4 #2         1 + 3 x V315 #2 drivers + V315 #2 

Syntax SPK connector pin D NL4 #2         1 - NL4 #2         1 - 3 x V315 #2 drivers - 

 

Standard NL8 (rack end) to 2 x NL4 (V221 end) bass break-out cable for 6 or 8 x V221 bass (6 shown in table) 
 

Standard NL8 to 2 x NL4 breakout 3 x V221 cabinet wiring (paralleled via NL4 link cables) Function 

NL8 1 + NL4 #1         1 + V221 #1, 2 & 3 NL4 socket 1 + V221 #1, 2 & 3 driver 1 +  
V221 #1, 2 & 3 

(paralleled) 
NL8 1 - NL4 #1         1 - V221 #1, 2 & 3 NL4 socket 1 - V221 #1, 2 & 3 driver 1 - 

NL8 2 + NL4 #1         2 + V221 #1, 2 & 3 NL4 socket 2 + V221 #1, 2 & 3 driver 2 + 

NL8 2 - NL4 #1         2 - V221 #1, 2 & 3 NL4 socket 2 - V221 #1, 2 & 3 driver 2 - 

NL8 3 + NL4 #2         1 + V221 #4, 5 & 6 NL4 socket 1 + V221 #4, 5 & 6 driver 1 +  
V221 #4, 5 & 6 

(paralleled) 
NL8 3 - NL4 #2         1 - V221 #4, 5 & 6 NL4 socket 1 - V221 #4, 5 & 6 driver 1 - 

NL8 4 + NL4 #2         2 + V221 #4, 5 & 6 NL4 socket 2 + V221 #4, 5 & 6 driver 2 + 

NL8 4 - NL4 #2         2 - V221 #4, 5 & 6 NL4 socket 2 - V221 #4, 5 & 6 driver 2 - 
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4.2  Recommended cable specifications for permanent installations 
 
 
 
 
 
 
 
 
 

 
Vero systems are usually supplied complete with all loudspeaker cabling ς see previous page for part numbers. However, where permanent installation requires 
cabling to be routed through the building structure via intermediate junction boxes and local 8-pin Syntax SPK tails, the following cable recommendations may 
prove useful. 

 
A good example of installation speaker cable is: 
Á Install grade loudspeaker cable LSZH 

(For installations in public buildings, clubs and cruise ships where Low Smoke Zero Halogen cables are specified. These cables are compliant with IEC60092, 
IEC60332.1, IEC60332.3C, IEC60754.1, IEC60754.2 and IEC60134.2) 

 
Low loss cable runs 
The following table gives the maximum cable lengths allowable to keep level losses below 0.6dB. 
 

 

Copper core cross 
sectional area mm2 

 

Nearest suitable 
AWG size 

 

8-ohm load 
 

metres (ft) 

 

4-ohm load 
 

metres (ft) 
 

 

2-ohm load 
 

metres (ft) 
 

2.50 mm2 13awg 36m (118ft) 18m (59ft) 9m (29ft) 
4.00 mm2 11awg 60m (197ft) 30m (98ft) 15m (49ft) 
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4.3  Loudspeaker polarity 
 

Loudspeaker cones and diaphragms create sound by moving in and out to modulate air pressure and velocity. It is important that all loudspeakers in a sound 
system move in the same direction when driven in unison. In other words, they should all have the same polarity. 

 
Same polarity όάƛƴ ǇƘŀǎŜέύ 
 
Loudspeakers with the same polarity will give: 
 

Á Good bass extension 
Á Good bass impact 
Á DƻƻŘ άōŜǘǿŜŜƴ ǘƘŜ ǎǇŜŀƪŜǊǎέ ǎǘŜǊŜƻ ƛƳŀƎƛƴƎ 

with a smooth central transition 
Á Solid centre-panned vocal imaging 

 
 
 
 
 

Opposite polarity όάƻǳǘ ƻŦ ǇƘŀǎŜέύ 
 
Loudspeakers with opposing polarities will give the following, 
depending on which section (bass, low-mid, high-mid or high) 
is incorrectly set up: 
 

Á Poor bass extension 
Á Poor bass impact 
Á tƻƻǊ άōŜǘǿŜŜƴ ǘƘŜ ǎǇŜŀƪŜǊǎέ ƛƳŀƎƛƴƎ - just hard left or 
ƘŀǊŘ ǊƛƎƘǘ άŘƛǎǘŀƴǘέ ŜŦŦŜŎǘǎ 

Á Vague and unstable vocal image. Centre-panned vocals will 
ǎƻǳƴŘ ƛƴŘƛǎǘƛƴŎǘ ƻǊ ǘƘƛƴ ŀƴŘΣ ŀƎŀƛƴΣ ǘƘŜ άŘƛǎǘŀƴǘέ ŜŦŦŜŎǘ 
will be evident. 
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It is usually quite easy to ensure that your loudspeakers are wired to the same polarity if all your loudspeakers are being driven via identical signal paths and 
equipment. Simply check that the same loudspeaker cable core colours are wired to the same + or ς pins at the amplifier end and at the loudspeaker connector 
end. 
 
If you cannot be certain that your signal paths are identical (you may be using a mix of old and new equipment or equipment from different manufacturers, for 
instance), check out the system using a polarity checker.  
 
A good polarity checker, such as the Funktion One ASPC1, will allow you to check not only your amplifier-loudspeaker combinations but also the entire signal path 
including mixers and crossover connections. 

 
Introducing the Funktion One Audio Systems Polarity Checker (ASPC1) 
 
Pulse generator 
Á XLR pulse generator output 
Á LED pulse indicator 

 
Detector 
Á Built in microphone  
Á LED polarity indicators 

 
General 
Á Belt pouch included 
Á Batteries included  
Á User Instruction Card 

 
The ASPC1 is a two-part system comprising a pulse generator and a detector. The pulse generator allows you to inject a special test signal anywhere in the signal 
path whilst the detector microphone lets you check the resulting loudspeaker polarity acoustically. See the ASPC1 user guide for more information. 
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i      Absolute polarity and live sound 
 

aŀƛƴǘŀƛƴƛƴƎ ŀōǎƻƭǳǘŜ ǇƻƭŀǊƛǘȅ ǘƘǊƻǳƎƘ ŀ ǎƻǳƴŘ ǎȅǎǘŜƳ ƳŜŀƴǎ ƴƻǘ ƻƴƭȅ ƳŀƪƛƴƎ ǎǳǊŜ ŀƭƭ ȅƻǳǊ ƭƻǳŘǎǇŜŀƪŜǊǎ ŀǊŜ άƛƴ ǇƘŀǎŜέ ōǳǘ ŀƭǎƻ ensuring that your microphones 
give a positive-going output voltage for a positive-going pressure, that there are no polarity reversals anywhere in the signal path and that your loudspeaker 
systems provide a positive pressure in response to that positive-going signal. 
 

Many natural sound sources, especially percussion and vocals, produce asymmetrical waveforms. It makes sense to ensure that a positive-going percussive impact 
creates a positive-going pressure for the audience to maintain that all-important bodily impact. Some recording engineers are also adamant that vocals overlay the 
band more clearly if absolute polarity is maintained. 
 

Common sense, then, suggests that, if ǿŜΩǊŜ ǳǎƛƴƎ ǇƻƭŀǊƛǘȅ-matched microphones and well-documented signal paths, why not maintain absolute polarity ς if only 
for consistency? 
 

 

 

5  Amplification and control  

5.1  Electrical and fire safety 
 
 

      Qualified and experienced system technicians only 

 
Funktion One Vero series loudspeakers are high power systems and should only be powered from professionally assembled, electrically safety-tested amplifier 
racks designed and installed by fully experienced system technicians.  
 

The following information is intended to be used by fully qualified personnel only. 
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Cabling 
 

Á Use the Funktion One loudspeaker cables supplied with your Vero system wherever possible 
Á Ensure that your cables are in good condition and free from damage 
Á Ensure that there are no loose conductor strands that could short out and create a fire hazard 
Á Keep connectors away from flammable furnishings as connectors can get hot under fault conditions 

 
If you need to make up bespoke cables for an installation: 
Á Use the appropriate cable conductor gauge for the loudspeaker being driven. See Section 4.2. 
Á Use fire retardant or low emission cables where these have been specified by the contract or by local safety regulations 
Á Ensure that your cables are properly assembled and free from damage 
Á Ensure that there are no loose conductor strands that could short out and create a fire hazard 
Á Again, keep connectors away from flammable furnishings as connectors can get hot under fault conditions 

 
Amplification 
 

Although your Vero system is supplied complete with fully assembled amplifier rack systems, the following points may still be relevant and should be adhered to: 
 

Á wŜƳŜƳōŜǊ ǘƘŀǘ ƘŜŀǾƛƭȅ ŎƭƛǇǇŜŘ ǇǊƻƎǊŀƳƳŜ ǎƛƎƴŀƭǎ Ŏŀƴ ŘƻǳōƭŜ ŀ ǇƻǿŜǊ ŀƳǇƭƛŦƛŜǊΩǎ output. See Appendix D. 
Á Keep amplifier racks properly ventilated and well away from flammable furnishings 

 

5.2  Power amplifier considerations 
 

PLM20K44 power output and limiter settings 
 

The PLM20K44 power amplifiers and preset libraries supplied with your Vero system fully comply with the AES power ratings of your Vero system drivers ς 
assuming they are used as suggested in the user guide. 
 
AES power ratings 
Modern loudspeaker drivers are specified to an AES standard. This specifies their long-term (typically 2 hour) band-limited AES power rating.  
 
Peak power ratings 
The AES band-limited test signal has a 6dB crest factor. This means that loudspeaker drivers can be specified with a peak power rating of 4 times their AES power 
rating - assuming suitable rms limiting is in place to protect the voice-coils from overheating on sustained signals. 
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5.3  Funktion One amplifier rack 
 

±ŜǊƻΩǎ ŀƳǇƭƛŦƛŜǊ ǊŀŎƪ ƛǎ ŜǉǳƛǇǇŜŘ ŦƻǊ ǘƘŜ ŎƘŀƭƭŜƴƎŜǎ ŀƴŘ rigours of the touring environment. 
 
The amplifiers and power distribution unit are fully shock mounted within the rack. 
 
It also features convenient retractable protective doors that store in the roof of the rack when not in use. 
Despite the extra shock mounting and the door stowage features, the Vero rack has a small footprint and 
may be flown where necessary. 

 
 
 
 

 
 
 

 
Each rack includes: 
 

Á A tour-ƎǊŀŘŜ ǎǳǎǇŜƴŘŜŘ мфέ ǊŀŎƪ ǎȅǎǘŜƳ ǿƛǘƘ ǎƭƛŘƛƴƎ ŘƻƻǊǎ 
Á A 3-phase mains distribution panel ς configured to either 230v phase-to-neutral (typical in Europe) 

or 208v phase-to-phase (typical in the USA), as required 
Á A 1-U rack space for user allocation (fitted with blank panel) 
Á 3 x Lab.gruppen PLM20K44 4-channel power amplifiers that include Dante network audio and Lake 

control facilities 
Á Two NL8-to-female Syntax SPK system link cables 

 
A standard 3 x PLM20K44 amplifier rack will provide all the power and control to drive up to: 
 

Á 8 x V60/V90 mid/high loudspeakers 
Á 4 x V315 mid-bass loudspeakers 
tƭǳǎΧ 

Á 6 x V221 bass cabinets* (2.67 ohms per channel) or 8 x V221 bass cabinets**  (2 ohms per channel) 
*Assumes two lots of 3 x parallel V221s driven in 2-channel (separate-driver) mode 
**Assumes two lots of 4 x parallel V221s driven in 2-channel (separate-driver) mode 
(See illustration later) 
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A single PLM20K44 amplifier will drive a 6-box array of 4 x V60 or V90 top cabinets plus 2 x V315 mid-bass cabinets via a single 4-pair Syntax SPK series cable. 
 

             
          PLM20K44 4-input/4 -output amplifier/control with system link cable and extension cable. 
 

The cabling (shown left) has been patched from the top (to follow the rigging sequence) but, as 
the V60/V90 connectors are fully paralleled pin-to-pin, any sequence is acceptable as long as the 
V315s are patched at the end of the cable run. 
 

We strongly recommend cable-picking to the rear pull-up Delta plate for ground-run cabling ς as 
shown on the left ς or to the FlyGrid jib if cables are dropped in from a truss. 
                                                                                                                                               6-box (4 x V60/V90, 2 x V315) array patch. (Different scale) 
                                                                                                                                                                                             Extension cable = black, Link cables = green, V315 break-out cable = red 

Extension cable and Link cable pin-outs ς see Section 4.1 for full details 
NL8 pairs 1 -to- 4 are through-connected to Syntax pairs; A-B & C-D (V315 mid-bass #1 & #2), E-F (V60/V90 mids), G-H (V60/V90 HFs) respectively. 
 

Syntax SPK-to-NL4 V315 break-out cable (shown red on right illustration) 
 

VC8BB02M Syntax SPK male to 2 x NL4 breakout 2 x V315 cabinet wiring Function 

Syntax SPK connector pin A NL4 #1         1 + NL4 #1         1 + 3 x V315 #1 drivers + V315 #1 

Syntax SPK connector pin B NL4 #1         1 - NL4 #1         1 - 3 x V315 #1 drivers - 

Syntax SPK connector pin C NL4 #2         1 + NL4 #2         1 + 3 x V315 #2 drivers + V315 #2 

Syntax SPK connector pin D NL4 #2         1 - NL4 #2         1 - 3 x V315 #2 drivers - 
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Each 2 x PLM20K44 amplifier system will drive a complete 12-box array of 4 x V60 and 4 x V90 top cabinets 
plus 4 x V315 mid-bass cabinets via two 4-pair Syntax SPK series cables. 

 

    
            2 x PLM20K44 4-input/4 -output amplifier/control with system link and extension cables. 
                                       Extension cables to array shown lower right. (Not to scale) 

 
The 12-box patch comprises two of the 6-box patches shown on the previous page. 
 

Again, the array cabling (shown right) has been patched from the top (to follow the rigging sequence) but, 
any sequence is acceptable as long as the V315s are patched at the end of each 6-box cable run. 
 

We strongly recommend cable-picking to the rear pull-up Delta plate for ground-run cabling ς as 
shown on the left ς or to the FlyGrid jib if cables are dropped in from a truss.  
                                                                                                                                                  

Each 6-box cable patch follows the same sequence as before. The incoming 4-channel extension cables Ĝ 

are shown in black, the 4-ch link cables in green and the V315 break-out cable are shown in red. 
 

 
 

                                                                                                                                                                                                                         12-box (4 x V60, 4 x V90, 4 x V315) patch (Different scale) 
                                                                                                                                                                                                                                                           Some cables shortened and false-coloured for clarity 
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A typical Funktion One 3 x PLM20K44 amplifier rack will drive a complete 12-box array of 4 x V60, 4 x V90 and 4 x V315 plus a compatible bass system comprising 6 
x V221 (2.67 ohms per channel) or 8 x V221 (2 ohms per channel) via: 
 

Á 2 x 1m NL8 -to- 4-ch Syntax SPK series female System Link cables (left) thenΧ 
Á 2 x 10m or 25m 4-ch Syntax SPK series male -to- female Extension cables (right ς male end shown) 
Á Local 2m 4-ch Syntax SPK series male -to- 2 x NL4 break-out cables daisy-chain from each block of four V60/90 cabinets to drive 2 x V315 cabinets per 

block (via NL4 pins 1+ & 1-) 
Á Standard NL8 -to- 2 x NL4 cables drive, typically, 6 or 8 x V221 cabinets 

 

See Section 4.1 for cable and pin-out details. 
 

                
    3 x PLM20K44 4-input/4 -output amplifier/control with system link, extension and                          Bass cable -to- 6 (or 8) x V221 stack patch showing NL8 -to- 2 x NL4 scheme 
                       bass cables. Cables to array shown lower right. (Not to scale)                                                                                                     (Different scale) 
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5.4  PLM20K44 ŀƳǇƭƛŦƛŜǊ ŀƴŘ 5ŀƴǘŜϰ ƴŜǘǿƻǊƪƛƴƎ ƻǾŜǊǾƛŜǿ 

The PLM20K44 is a Powered Loudspeaker Management system that includes all the necessary DSP functions to run a Funktion One Vero system to full 
specification. For further PLM20K44 4-channel amplifier details go to:  http://labgruppen.com/view-model/plm-plus-series/plm-20k44 

 

 
Lab.gruppen PLM20K44 signal path 

 
The PLM20K44 amplifier is designed to be controlled by Lake® Controller ǎƻŦǘǿŀǊŜ ƻǾŜǊ ŀ 5ŀƴǘŜϰ ƴŜǘǿƻǊƪ - an Ethernet-based digital audio and control 
technology ς using standard Cat-5e or Cat-6 (recommended) cabling. Fibre-optic cabling can also be used for long site runs. 
 

For information on Lab.gruppen PLM+ series amplifiers, Lake Controller and Café software, manuals and other documentation, go to: 
www.labgruppen.com/Categories/c/Labgruppen/Downloads and click through the appropriate categories and sub-pages. 

 
 

 

We also strongly advise keeping your PLM20K44 amplifier firmware up to date to ensure compatibility with other Lab.gruppen & Lake updates. 
 

To do this, follow the instructions in the Lake Controller Operation Manual (address above). 
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5.4.1  5ŀƴǘŜϰ ƴŜǘǿƻǊƪ 
 

 

Unless you have completed Audinate-approved Dante training and are fully qualified to Dante Certification Level 2, we recommend that you leave Dante 
network design to the experts. 
 

Audinate training will ensure that you configure networks ς often linking a wide range of pro-audio products ς in a reliable and fail-safe manner. 
 

For further information about training see: www.audinate.com/resources/training-and-tutorials/dante-certification-training. 
 

 
Direct PLM Series amplifier control without switches 
Although it is possible to patch a laptop directly into several daisy-ŎƘŀƛƴŜŘ t[a {ŜǊƛŜǎ ǇƻǿŜǊ ŀƳǇƭƛŦƛŜǊǎ ōȅ ǳǎƛƴƎ ŜŀŎƘ ŀƳǇƭƛŦƛŜǊΩǎ ǎŜŎƻƴŘŀǊȅ 9ǘƘŜǊƴŜǘ ǇƻǊǘ ŀǎ ŀ 
άƭƻƻǇ ǘƘǊǳέΣ [ŀōΦƎǊǳǇǇŜƴ ŘƻƴΩǘ ǊŜŎƻƳƳŜƴŘ ǘƘƛǎ ƳŜǘƘƻŘ ŦƻǊ 5ŀƴǘŜ ƻǇŜǊŀǘƛƻƴΦ 5ŀƛǎȅ-chaining can also cause latency build-up. 
 

Dante network routing is, therefore, usually performed via multiple switches ς at front-of-house, to handle Dante audio from the console and control from a 
laptop, and in each amplifier rack so that the audio and/or control may be starred to the individual PLM Series amplifiers. The FOH laptop is often augmented by a 
tablet via a wireless access point (WAP) for in-field listening adjustments. See the following page for a network example featuring dual modular redundancy. 

 
Switch considerations 
Dante technology is based on standard network design techniques. A confusing number of network switches are available so here are some switch 
recommendations: 
 

Choose switches (e.g. CISCO SG300-20 or direct replacements) that provide: 
 

Á Robust, rack-mount construction 
Á tǊƻŦŜǎǎƛƻƴŀƭ L9/ Ƴŀƛƴǎ ŎƻƴƴŜŎǘƻǊǎΦ {ǿƛǘŎƘŜǎ ǿƛǘƘ Ƨǳǎǘ ŀ ŦŜǿ ǇƻǊǘǎ ƻŦǘŜƴ ǳǎŜ άǿŀƭƭ-ǿŀǊǘέ ŘƻƳŜǎǘƛŎ-style power units that are easy to lose or damage 
Á 1000BASE-T (or better) switch-to-switch operation 
Á Non-blocking layer-2 ς so that all ports will continue to work reliably at 1.488Mpps packet throughput per port 
Á SFP module support ς to allow fibre connections to be used for long-distance links 
Á Managed facilities for configuration and monitoring. This will enable switches to be optimised for Dante use by implementing or disabling various features 
Á Ability to disable any Energy Efficient Ethernet (EEE) or power-saving feature ς ǘƻ ŀǾƻƛŘ ǘƘŜ ǎǿƛǘŎƘ άŦŀƭƭƛƴƎ ŀǎƭŜŜǇέ 
Á DSCP (DiffServe Code Point) QoS (Quality of Service) ǘƻ ŜƴǎǳǊŜ ǘƘŀǘ 5ŀƴǘŜΩǎ ŎƭƻŎƪΣ ǘƘŜƴ ŀǳŘƛƻ ǘŀƪŜ ǎǘǊƛŎǘ ǇǊƛƻǊƛǘȅ 
Á RSTP (Rapid Spanning Tree Protocol) capability ς ǎƻ ǘƘŀǘ ƳǳƭǘƛǇƭŜ ǎǿƛǘŎƘŜǎ Ŏŀƴ ōŜ ǇƭŀŎŜŘ ƛƴ ŀ άŦŀƛƭ-ǎŀŦŜέ ǊƛƴƎ ǘƻǇƻƭƻƎȅ 

 

Note that PLM Series power amplifier Ethernet ports must never be placed within  ŀ ǊƛƴƎ ŀǎ ǘƘŜȅ ŘƻƴΩǘ ǎǳǇǇƻǊǘ w{¢t 
 

 

For further Dante network advice, please see: www.audinate.com. 
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Dante network example with dual modular redundancy 
 

 
 

Dual modular redundancy networks ǘŀƪŜ ŀŘǾŀƴǘŀƎŜ ƻŦ ǘƘŜ t[aҌ ǇƻǿŜǊ ŀƳǇƭƛŦƛŜǊǎΩ ǇǊƛƳŀǊȅ ŀƴŘ ǎŜŎƻƴŘŀǊȅ network ports by employing two networks comprising 
separate cabling and switches. The system is configured so that secondary network cabling and switches take over if a primary network element fails. 
 

For further information and current thinking on network design, see: www.audinate.com/resources/training-and-tutorials/dante-certification-training. 
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6  System design 
 

6.1  Hearing safety 
 
 

  Enjoy your system responsibly 
 

Funktion One loudspeaker systems are designed to provide extensive audience coverage at low distortion and are capable of producing very high near-field sound 
pressure levels. 
 

The richness and impact of a powerful sound system can be great fun and very exhilarating; but please consider others by following the advice below. 
 

 
Á Design your system for good projection and coverage without overexposing specific audience areas to damaging levels. Individual audience members 

should not be exposed to levels significantly greater than levels at the mix position. 
 

Á 5ƻƴΩǘ ǇƭŀŎŜ ȅƻǳǊ ŜŀǊǎ ǘƻƻ ŎƭƻǎŜ ǘƻ ƘƛƎƘ ǇƻǿŜǊ ƭƻǳŘǎǇŜŀƪŜǊ ǎȅǎǘŜƳǎ ŘǳǊƛƴƎ ǎȅǎǘŜƳ ǎŜǘ-ups. Erroneous patching or un-muting by others could generate 
unexpected and damaging sound pressure levels during set-up. 

 
Á Wearing ear plugs may be a sensible precaution during prolonged system set-ups but remember that you have a duty of care towards other people who 

may be working in the area. Operators should always be fully aware of the sound levels they are producing and should not wear ear plugs whilst staff or 
audience members are present. 

 
Á Hearing loss is cumulative and can result from long-term exposure to sound pressure levels as low as 85dBA. Installers and get-in crew should consider 

long-term staff exposure when positioning high power loudspeaker. Managers should rotate staff - especially security staff at the front of the audience - to 
minimise each staff memberΩǎ ŎǳƳǳƭŀǘƛǾŜ ŜȄǇƻǎǳǊŜΦ 

 
Á Check the relevant noise exposure/noise at work regulations and comply with them. If in doubt, seek expert advice. 
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If no noise exposure or noise at work regulation is available, we suggest the following LAeq* (A-weighted Equivalent Continuous spl) and peak spl limits for staff: 
 
*LAeq is referred to as dBA Leq on some meters 
 

85dB LAeq - 8hrs 
 

88dB LAeq - 4hrs 
 

91dB LAeq - 2hrs 
 

94dB LAeq - 1hr 
 

97dB LAeq - 30mins 
 

100dB LAeq - 15mins 
 

 

Instantaneous/peak sound pressure levels must never exceed 137dB (C-weighted). 
 
Leq is the average spl over a defined time period. We suggest averaging and logging LAeq, and logging peak spl, over consecutive industry-standard 15 minute 
periods. 
 
LAeq may be logged with an integrating spl meter or by using a calibrated microphone and IO with the appropriate sound measurement software. 

 
Note! 
Unweighted instantaneous sound pressure levels (especially where there's a solid bass presence) will be considerably higher than the dBA LEQ figures imply. This is 
because LEQ measurements are averaged over a considerable period of time and the applied A-weighting curve significantly under-represents the LF and HF 
content. 
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6.2  Typical array design using Funktion One Projection software 
 

Projection 
Funktion OneΩǎ Projection design and prediction software allows Vero users to optimise array designs for smooth audience coverage and impact. 
 

Vero users may request Projection and a user-licence directly from Funktion One or from your local Funktion One distributor. 
 

Projection also alerts you if your proposed array design is not feasible or is unsafe. Genuine Projection software will always require a Funktion One user-licence. 
 

Windows OS 
Projection is designed for Microsoft Windows operating system and has been thoroughly tested on all versions from Windows 7 onwards.  
 

Mac (iOS) 
LŦ ȅƻǳΩǊŜ ŀ aŀŎ (iOS) ǳǎŜǊΣ ȅƻǳ Ŏŀƴ ǎǘƛƭƭ Ǌǳƴ tǊƻƧŜŎǘƛƻƴ ƻƴ ȅƻǳǊ aŀŎ ōȅ ƛƴǎǘŀƭƭƛƴƎ !ǇǇƭŜΩǎ Bootcamp. 
See www.apple.com/support/bootcamp/ for further information or contact your local Mac expert. 
 

Projection Preferences 
Once Projection is installed and booted up, some of its parameters may be tailored to your 
personal preferences as follows: 
 

 
 
Click through Settings > Application Settings to select your Startup, Autosave, Update, Logfile, 
Distance Unit and Mass Unit preferences.                                                                                           Ĕ 
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Click through Settings > File Settings > General to select your initial 3D coverage 
prediction preferences. If in doubt, tick both boxes.                                                 Ĕ 
 

 
 
 
 
 
     Click through Settings > File Settings > SPL Colours to select your initial 3D coverage  
     SPL preferences. 
 

     ē    The settings shown here are a good starting point. 
 
 
 
 
 

 
 
Click through Settings > File Settings > Climate to select your initial environmental 
parameters. Air absorption and, therefore, long-distance high frequency attenuation, 
varies with temperature and relative humidity.                                                                 Ĕ 
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Array design example 
The easiest way to learn to use Projection is to practise designing a system from scratch. ̧ ƻǳΩƭƭ find this easier if you have Projection running on a laptop while you 
follow this work-through for a typical 12-cabinet sports arena system. (You can always read this guide on an extension screen, tablet or smart phone) 

 

 
The arrow numbers refer to the points below. All mouse clicks are left button clicks unless noted otherwise 

 
1) Select Venue from the View menu box if it is not already highlighted ς Projection usually defaults to this at start-up 
2) A Grid on/off  switch is available in the Tools menu (top centre). (Metric or imperial parameters may be chosen in Settings > Applications settings - top left) 
3) A Snap to grid function is also available in the Tools menu. This automatically aligns your venue surfaces with the nearest grid point if required 
4) Click on the appropriate audience section shape in the Add Surface menu box and then click in the main display area of the screen to add it 
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5) The new surface will appear with a properties strip on the left of the screen This allows you to adjust thŜ ǎǳǊŦŀŎŜΩǎ Width, Depth, orientation (Angle) plus 
Front and Back heights with respect to 0m. The main shape parameters can also be altered by dragging the nodes (white dots). 
 

The X & Y Reference Point settings (to left of 5 arrow) position the centre-left of the surface with respect to the X (0m) & Y (0m) datum point (circled). 
 

The Calculation Offset (circled) allows average audience ear heights to be taken into consideration. This ear height is used for coverage predictions and 
will appear as a broken line just above the relevant surface when side views are selected later. A standing audience has been assumed for the floor. 

 

The properties strip (screen left) also allows surfaces to be Mirrored ς i.e. mirror-image paired ς in the X or Y axes. This feature is more likely to be used 
when a complex, symmetrical venue is being modelled ς see later in this work-through 

 
6) You can centre your plot on the screen at any time by clicking the Zoom to fit button in the Zoom menu 
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7) Extra venue surfaces may be added by clicking the required shape in the Add Surface menu and then clicking in the approximate position on the venue 
plan. The surface may then be dimensioned and precisely positioned by typing in the properties strip (to left of main screen) or by dragging the (white dot) 
nodes. A 2.5m high rectangular stage has been added. Surface heights are relative to 0m in Projection ς i.e. the floor level in this example. 

 

Surfaces or objects can be dragged and dropped to a new position. You can use your Delete key to delete a selected (highlighted) surface or object. 
 

If you have Snap to grid       selected in the Tools menu, your surface will move in grid-marker increments. Grid-marker spacing varies with zoom ς zoom in 
or out for smaller or larger increments by using the Zoom menu + and ς buttons . . . or by clicking in the plot area and then using your mouse wheel. 

 
 

A ǊŜŎǘŀƴƎǳƭŀǊ ǎǳǊŦŀŎŜΩǎ Ǌeference point is usually centre-left unless the surface has been rotated from its default 0 degs using the Angle text box. In the example 
shownΣ ǿŜΩǾŜ ǊƻǘŀǘŜŘ the stage surface (7) by 180º (circled) so that down-stage-centre and audience front centre coincide with the X (0m), Y (0m) datum point. 
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²ŜΩƭƭ ŎƻƴǘƛƴǳŜ ǘƻ ōǳƛƭŘ ǳǇ ƻǳǊ ŀǊŜƴŀ ŜȄample by adding raked bleacher seating at the rear (highlighted). 
 

 
 
 

Á The bleacherΩǎ Front Height is set to 2m above the floor. It rises to a Back Height of 10m above the floor 
Á The Calculation Offset is set at 0.9m for the average ear height above the bleacher surface 

 
Contextual Plane, Venue or Project text boxes 
The properties strip Plane number text box (Plane 3 in the above illustration) may be double-clicked and edited for 
any selected area at any time to give the surface a friendly name; fƻǊ ŜȄŀƳǇƭŜΣ άRear bleacherέ  Ĕ 

 
 

When no surface is selected, a Venue name may be typed into the empty text box. The venue also determines the Project ƴŀƳŜ ŦƻǊ tǊƻƧŜŎǘƛƻƴΩǎ ΦǇŘŦ ŜȄǇƻǊǘǎΦ 
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bƻǿ ǿŜΩll add some arena side bleachers (highlighted). 
 

 
 
Notes: 
Á The (upper) side bleacher is added as a rectangular surface ς but ƛǘΩs rotated 90º counter-clockwise (see arrow in upper highlighted area and the properties 

strip Angle text box - circled) and positioned to align its front Reference Point half-way along the (upper) side of the floor (X = 34m, Y = 21m) 
 

Á The bleacher starts 2m above the floor level and rises to 10m above floor height at the back (see Front Height and Back Height - circled) 
 

Á The Calculation Offset is set at 0.9m above the bleacher surface 
 

Á Once the upper side bleacher is correctly dimensioned and positioned, the Mirror Surface in X-axis button is selected to create a mirror-image bleacher on 
the opposite side ƻŦ ǘƘŜ ǾŜƴǳŜΩǎ · ŘŀǘǳƳ ƭƛƴŜ. The mirrored (house left) surface then tracks the original (adjustable) house-right surface. 
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And, finally, ǿŜΩƭƭ ŀŘŘ ǘƘŜ ŎƻǊƴŜǊ ǎŜŀǘƛƴƎ ŀǊŜŀǎ (highlighted). 
 

 
 

Notes: 
Á Triangular surfaces may be added by left-clicking the triangular shape (circled) in the Add Surface menu and then clicking on the venue plan as before 

 

Á The triangular surface may then be accurately dimensioned and positioned by entering X, Y and Z (height) positional coordinates into the appropriate 
properties strip text boxes (screen left ς shown boxed). Each corner of the triangle is allocated a point number as illustrated above 

 

Á TƘŜ ǎƘŀǇŜΩǎ ƴƻŘŜǎ (the small white dots) may also be dragged to adjust the appropriate X and Y point positions if you wish 
 

Á The upper corners (Points 1 and 3) are 10m above floor height and the lower corner (Point 2) aligns with the side and rear bleachers 2m above the floor 
 

Á Again, the Mirror Surface in X-axis button (circled) has been selected to create a mirror-image surface on the opposite side ƻŦ ǘƘŜ ǾŜƴǳŜΩǎ · ŘŀǘǳƳ ƭƛƴŜ. 
And again, the original house-right corner surface remains the reference surface for further adjustments. 
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Other surface shapes 
 

The Add Surface menu offers additional surface shapes (not used in our design example). 

 

 
Trapezoidal example 

 
Trapezoidal surface 
A trapezoidal surface may be selected from the Add Surface menu and clicked into position. (A standard trapezoidal shape is shown above). 
 

TƘŜ ǎƘŀǇŜΩǎ Ƴŀƛƴ ŘƛƳŜƴǎƛƻƴǎ ς in this example, Front and Back Width, Depth and orientation Angle - may be typed into the appropriate property strip boxes. 
 

The front width, back width, overall width or depth may also be adjusted by dragging the appropriate (white dot) nodes. Note that the trapezoidal shape remains 
symmetrical, ǎƻ ƛǘ ŘƻŜǎƴΩǘ ƳŀǘǘŜǊ ǿƘŜǘƘŜǊ ȅƻǳ ǳǎŜ ǳǇǇŜǊ ƻǊ ƭƻǿŜǊ ǿƛŘǘƘ ƴƻŘŜǎΦ 

 
Right-angled trapezoidal surface 
A right-angled trapezoidal surface may be placed, dimensioned and orientated in a similar way. The only difference is that the right-angled trapezoidal shape is 
asymmetrical ς angled on one side and squared off on the other ς as illustrated in the Add Surface menu above. 
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Vertical rectangular panels 
 

Vertical rectangular surfaces may be added by left-clicking the         menu item (highlighted in blue in the Add Surface menu) and then left-clicking on the venue 
plan as before. WeΩƭƭ ǳǎŜ ǘƘŜǎŜ ƭŀǘŜǊ ǘƻ ǎƛƳǳƭŀǘŜ ǾƛŘŜƻ ǎŎǊŜŜƴǎ ǘƻ ŘŜƳƻƴǎǘǊŀǘŜ ǎƻǳƴŘ ǎƘŀŘƻǿƛƴƎΧ 
 

        
                                                              Panel at 0 degs                                                                                                                                         Panel at 90 degs 

 
Notes: 
Á The surface may then be accurately dimensioned and vertically positioned by entering its Width, Back (top) and Front (bottom) Heights 

(Note that the Venue view is always a plan view, so vertical sizes and positions will only be visible as text box figures . . . until we switch to 3D view later) 
 

Á The surface may then be accurately positioned horizontally by entering its X & Y Reference Points (circled) or dragging and dropping it into position 
 

Á TƘŜ ǎǳǊŦŀŎŜΩǎ nodes (the small white dots) may also be dragged to adjust the width symmetrically about its X/Y reference point 
 

Á The surface may be orientated, with respect to the Y-axis, by entering the required figure into the Angle text box (shown 0º on the left illustration and 90º 
on right) 

 

Á Again, the Mirror Surface in X or Y-axis buttons may be selected to create a mirror-image surface on the opposite side ƻŦ ǘƘŜ ǾŜƴǳŜΩǎ ǊŜǎǇŜŎǘƛǾŜ ŘŀǘǳƳ 
lines 
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Segments 

 

       
                                                              Circular segment                                                                                                                                      Annular segment 

 
Circular segment 
Once a circular segment has been selected from the Add Surface menu and clicked into its initial position, its main dimensions ς Radius and Segment Angle - may 
be typed into the appropriate property strip boxes. Again, the main dimensions may be adjusted by dragging the appropriate nodes. Overall orientation is set 
using the Rotation Angle text box. 
 

Note that a complete circle may be obtained by setting or dragging the segment angle to 360º. 

 
Annular segment 
An annular sŜƎƳŜƴǘΩǎ Ƴain dimensional properties are set by the Inner Radius, the Depth (the space between the inner and outer radii) and the Segment Angle. 
Overall orientation is set using the Rotation Angle text box. Again, dimensional parameters may be adjusted by dragging the appropriate nodes. 
 

Note that a complete annular ring may be obtained by setting or dragging the segment angle to 360º. 

 
 

http://www.vero-system.com/


www.vero-system.com                                                                                                    38                                                                       © Funktion One Research Limited 2018 
 

 

Check your venue design 
The easiest way to check that your venue design is the correct shape is to briefly switch Projection to 3D view. 

 

 
 
Start with a simple isometric plan view ǘƻ ƻǇǘƛƳƛǎŜ ǘƘŜ ǾŜƴǳŜ ƳƻŘŜƭΩǎ Ǉƻǎƛǘƛƻƴ: 
 

Á Click the 3D button (arrowed) in the top left View menu to view your venue model 
 

Á New models usually default to an isometric plan view ς ƛŦ ȅƻǳǊǎ ŘƻŜǎƴΩǘΣ ǎŜƭŜŎǘ Isometric View (arrowed) in the top centre View Mode menu 
 

Á Centre and expand the view to fill the display area by clicking on the Zoom to fit button (arrowed) in the Zoom menuΦ ¸ƻǳΩǊŜ ƴƻǿ ƛƴ ŀ ƎƻƻŘ Ǉƻǎƛǘƛƻƴ ǘƻ 
view your venue in 3D. 
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You can use your mouse to rotate and roll your venue model to inspect for any venue modelling errors or omissions in whichever View mode you prefer. Some 
engineers and draftsmen prefer the more purist Isometric view whereas many users prefer Perspective view (arrowed) ŀǎ ƛǘ ƭƻƻƪǎ ƳƻǊŜ ƴŀǘǳǊŀƭΦ LǘΩǎ ȅƻǳǊ ŎƘƻƛŎŜΦ 

 

 

 
A 2-button mouse with a centre-wheel (for zoom functions) is ideal ς ōǳǘΣ ƛŦ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ŀ ŎŜƴǘǊŜ ǿƘŜŜƭ ƻǊ ŜǉǳƛǾŀƭŜƴǘΣ ȅƻǳ Ŏŀƴ ǳǎŜ ǘƘŜ ƻƴ-screen Zoom buttons. 
 

Á Left click and drag from side-to-side to rotate your venue model about its vertical datum point Z-axis ς see above 
Á Left click and drag up and down to roll your venue model about its current horizontal centre line ς see above 
Á Right click and drag from side-to-side to pan your venue model horizontally 
Á Right click and drag up and down to pan your venue model vertically 
Á Push your mouse wheel forward to push your model away from you (zoom out) 
Á Pull your mouse wheel backwards to pull your model towards you (zoom in) 
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hƴŎŜ ȅƻǳΩǊŜ ƘŀǇǇȅ ǿƛǘƘ ȅƻǳǊ ǾŜƴǳŜ ŘŜǎƛƎƴΣ ȅƻǳ Ŏŀƴ go back to Venue view, zoom to fit if necessary and then add loudspeaker positions and design the arrays.  

 

 
 

8) Go to the Add Object box, select the Add an Array symbol (8a), then click the required array position, in this case house right (8b) in the main display area 
 

In the above example, the Mirror Array in X-axis button has been selected to form a stereo pair (button circled, and mirror-image array arrowed). Note 
that the original house-right array remains the reference array for any array adjustments. 
 

9) Array position and grid height may be edited using the X, Y & Z Reference Point text boxes (9a) and orientation may be set using the Pan Angle text box 
(9b). Stereo toe-in/out is usually unnecessary as each V60/V90 already incorporates inner and outer mid sections for excellent stereo image width. 

 

Tip: You may find yourself selecting an adjacent surface when trying to left-click on an object (an array in this case). If this happens, simply switch to a right-  
        click to select the object. 
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A quick note about the distance measuring tool 
A distance measuring tool is available in the Tools menu if required. Propagation time is accurately calculated for the distance being measured. As the speed of 
sound varies with temperature, the propagation time is calculated at the temperature entered via Settings > File settings > Climate ς see earlier in this section. 

 

 
 
Á Click on the distance measuring tool icon -         - in the Tools menu (shown highlighted in blue above) to activate the tool 
Á Left-click at your required start position. In the above example, ǿŜΩǾŜ ǎǘŀǊǘŜŘ ŀǘ ǘƘŜ ǘƻǇ ƻŦ our proposed array position 
Á Now left-click at your required end position. In the above example, ǿŜΩǾŜ ŜƴŘŜŘ ŀǘ ǘƘŜ ǘƻǇ house-right corner of the rear bleacher 
Á Inspect the Start and End Position coordinates and make fine adjustments by editing the appropriate X, Y or Z coordinate text boxes ς paying attention to 

the height (Z) coordinate to ensure accuracy 
Á Measurement results will be shown at the top of the Measuring Tool strip (labelled Measurement result in the above illustration): 

¶ Distance is the direct path length from your current start position to your current end position 

¶ Time is the time it takes sound to travel that direct path length at the temperature you entered via Settings > File settings > Climate 

¶ The X, Y and Z Offsets are the differences between the start and end position X, Y and Z coordinates 

 
Note that the distance measuring tool will remain active all the time its icon -         - is highlighted in the Tools menu so a third click will create a new measurement 
start position and so on (CAD users will be familiar with this). The tool may be toggled on and off by clicking on the distance measuring tool icon. 
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bƻǿ ōŀŎƪ ǘƻ ƻǳǊ ǎȅǎǘŜƳ ŘŜǎƛƎƴ ǇǊƻŎŜǎǎΦ ²ŜΩƭƭ ŎƻƴǘƛƴǳŜ with an ŀǊǊŀȅ ŘŜǎƛƎƴ Χ 
 

10) The Side button (arrowed 10) may now be clicked in the View menu to display a side view of the venue with the grid in place. The first cabinet may now be 
added by selecting the appropriate V60, V90 or V315 from the Cabinet drop-down box (circled). The grid Inclination (arrowed) should be set, initially, to 
aim towards the furthest/ highest listener position ς see the thin blue line on the illustration. 

 

When working outdoors, a slight rear-audience overshoot is sometimes sensible to hedge against temperature and wind gradients and to ensure that the 
ŦǳǊǘƘŜǎǘκƘƛƎƘŜǎǘ ŀǳŘƛŜƴŎŜ ƳŜƳōŜǊǎ ōŜƴŜŦƛǘ ŦǊƻƳ ǘƘŜ ǳǇǇŜǊ ŀǊǊŀȅ ǎŜŎǘƛƻƴΩǎ ƳŀȄƛƳǳƳ D9{ όDŜƻƳŜǘǊƛŎ 9ƴŜǊƎȅ {ǳƳƳŀǘƛƻƴύ ς ǎŜŜ ƭŀǘŜǊΧ 
 

 

 
 

11) If necessary, use the Zoom + or - buttons (arrowed 11) ς or click in the plot area and use your mouse wheel. You may need to use the horizontal scroll bar 
(if present). Also, remember that the left property strip-to-main plot area divider (under the left Grid inclination arrow above) may be moved if required.  
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12) Extra Vero loudspeakers may now be added by clicking the appropriate + button (arrowed 12 above) and then selecting the required V60, V90 or V315 
cabinet from the extra drop-down box. 
 
The inter-cabinet Angle parameter will also be functional once subsequent loudspeakers are added. {ŜŜ ōŜƭƻǿΧ 

 

 
 

13) Start with an array length of approximately 6% of the distance to be covered. Set the array height for good sight line compliance by editing the grid height 
figure in the Reference PointΩǎ Z text box (arrowed top left). 

 

Adjust the inter-cabinet angles, initially, for equally-spaced ray positions (see yellow (V90) and blue (V60) arrows above) at ear height for each audience 
area. Each angle (arrowed 13) sets the splay angle between a cabinet and the one beneath it. These angles may be adjusted to optimise coverage later 

 

14) Projection will indicate Front and Rear Pickup Point loading (arrowed 14). An on-screen safety warning will appear if rebalancing is required ς see later 
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The V315s are placed towards the centre of the array to provide optimal pattern control for good audience impact combined with excellent mid-bass attenuation 
beneath the array. See Appendix C for more about under-array bass attenuation. 
 

 
 
Á Each Angle setting refers to the Lambda mechanisms at the bottom of the cabinet and sets the splay angle between the cabinet and the one below 

 

Á The Inclination angle sets the grid up-tilt (+ve) or down-tilt  (-ve). The top cabinet is always parallel to the grid so the grid defines the overall array tilt 
 

Á ¢ƘŜ ōƻǘǘƻƳ ŎŀōƛƴŜǘΩǎ [ŀƳōŘŀ ƳŜŎƘŀƴƛǎƳ ƛǎ ǎŜǘ ǘƻ Park ς i.e. it is left concealed to keep things looking neat and tidy 
 
Fine adjustments may be required once the coverage predictions have been checked. Rigging properties are updated as you design the array. 
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Projection rigging safety warnings and solutions 

 
 
 
 
 
 
 
 
 
 
 

 
ē Projection will display an        Unsafe Setup warning - with hints and 
information at the bottom left of your screen - if the design needs attention. 
 
ά¦ƴǎŀŦŜέ ǎŜǘǳǇǎ Ŏŀƴ ǳǎǳŀƭƭȅ ōŜ ŦƛȄŜŘ ōȅ ŀŘƧǳǎǘƛƴƎ ǘƘŜ Front and Rear Fly Point 
positions and/or the Grid and Jib Modes (thŜ ƧƛōΩǎ ǊŜŀǊ Ǉǳƭƭ-up extension). 
 
In this example (see left) both Front Fly Points (Red X), Grid mode (Red X) and the 
Jib Mode (Yellow X) have been flagged up for possible attention. 
 
Changing the Jib Mode from Shut to Open fixes the jib problem and changing the 
Front Fly Point from B to A fixes the lift point problem (see right). 
 
Ideally, the array should be flown at a height and inclination that gives a 
reasonable balance between front and rear pickup point loads. In practice, of 
course, sight line considerations influence the choice of array height, and the 
array often needs to be tilted to avoid echoes from behind the audience. This 
makes it difficult to balance the front and rear pickup point loads. If a well-
balanced hang is unachievable, try not to exceed a 4:1 imbalance ς and never, 
under any circumstances, ignore safety warnings. 
 

 

                         Unsafe                                                                                                                                                                                                                      Safe 
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6.2.1  Initial amplifier patch and coverage predictions using Projection 
 
OncŜ ȅƻǳΩǾŜ ŎƻƳǇƭŜǘŜŘ ȅƻǳǊ ǾŜƴǳŜ ŀƴŘ array designsΣ ȅƻǳΩƭƭ ƴŜŜŘ ǘƻ ǿƻǊƪ ƻǳǘ ŀƴ ƛƴƛǘƛŀƭ ŀƳǇƭƛŦƛŜǊ ǇŀǘŎƘ ǎƻ ǘƘŀǘ Projection receives the correct power amplifier gain 
information for its coverage predictions. 
 
A Mirrored Array button is provided on each amplifier for stereo systems. Only one side of the PA needs to be set for symmetrical systems. 
 

 
  
Á Click on Docs then the Rack symbol (highlighted in blue) to view the Amplifier List. 

 

Á Amplifiers may be added or deleted using the buttons shown above 
 

Á Channels 1 & 2 are normally used for individual V315s 
 

Á Channels 3 & 4 are allocated for up to four V60s or up to four V90s per channel 
 

Á Drop-down menus allow channels to be allocated and gains to be set 
 

Á Initially leave the overall amplifier gains and the V315 (Ch1 & Ch2) band gains set to 0dB 
 

Á Initially set the amplifier Overlay selector to None. όaƻǊŜ ŀōƻǳǘ ǘƘƛǎ ƭŀǘŜǊΧύ                          Projection amplifier list pdf ς ƳƻǊŜ ŀōƻǳǘ ǘƘƛǎ ƭŀǘŜǊΧ 
 

Á Press the PDF button to save the Amplifier List if you wish to save your settings as a pdf at any time  ì 
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You are now ready to predict ȅƻǳǊ ±ŜǊƻ ǎȅǎǘŜƳΩǎ ōǊƻŀŘōŀƴŘ ƻǊ мκоrd octave spl coverage by ǳǎƛƴƎ tǊƻƧŜŎǘƛƻƴΩǎ D9{ (Geometric Energy Summing) simulation. 

 

 
 

1) Click the 3D button (arrowed 1) to view your venue model - initially in plan-view*. 
 

2) Centre and expand the view to fill the display area by clicking on the Zoom to fit  button (2) 
 

3) * If ȅƻǳǊ ƳƻŘŜƭ ŘƻŜǎƴΩǘ ŀǇǇŜŀǊ Ŧƭŀǘ ƛƴ plan-view, select Isometric View (3) in the View Mode 
 

4) Ensure that coverage calculations are updated for every array change made by selecting Auto Calculate (4) 
 

5) Select the required coverage plot resolution from the Resolution dropdown menu (5). 0.5m (maximum resolution) has been chosen in this example 
 

6) Select the required broadband or 1/3rd octave centre frequency from the Frequency dropdown menu (6). 1kHz 1/3rd octave is shown above 
 

7) Edit the spl amplitude colour scale by clicking on the Edit Scale button (7). Note that broadband plots will show higher spl figures than 1/3rd octave plots 
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